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[bookmark: _Toc74041698]Introduction
IRBNet Insight Reports provide the end user with a detailed set of data extracts that give unique and timely views of operations at all VHA sites that are online in IRBNet. However, these reports can contain data that isn’t relevant to the user, and can be a bit difficult to read, so ORPP&E has developed a series of Microsoft Excel macros that reformat the reports into a more user friendly format. 
[bookmark: _Toc74041699]Accessing Insight Reports
Insight Reports are delivered via email at regular intervals, and cover a wide variety of data related to VHA research projects. IRBNet has created a guide (embedded below) that summarizes each of the reports they can provide. To receive these reports, IRB Net Support at  govsupport@IRBNet.org and let them know which reports you’d like delivered, and how often you’d like to receive them (daily, weekly, monthly, etc.).




[bookmark: _Toc74041700]Opening Insight Reports
IRBNet Insight Reports are delivered as a zipped file; however for security purposes they are delivered in .zzz file format to your email. You will need to save the file in the .zip format before opening.

· In Outlook, select the dropdown menu next to the filename and click on “Save As” 
[image: ]


· Change the file extension from “.zzz” to “.zip”. In the “Save as Type” field, select the dropdown menu and choose “All Files.” See the two screenshots for the before and after.

[image: Graphical user interface, text, application, email

Description automatically generated]Your file should now be saved as a .zip file; simply open the file to view the Excel files that contain the Insight Report data.
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[bookmark: _Toc74041701]Saving and Running Excel Macros

[bookmark: _Toc74041702]Saving the Macro: One-time Process
Steps 1 and 2 only need to be completed once.
[bookmark: _Toc74041703]Step 1: Unhiding the Macro Folder

1. Open File Explorer.  It should be pinned to the bottom menu of your screen, and the icon looks like this:  [image: ]
2. In File Explorer, navigate to the top menu and choose the View tab. 
3. [image: ]Check the “Hidden Items” checkbox if it isn’t checked already, as in the below screenshot.
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[bookmark: _Toc74041704]Step 2: Saving the Macro to your hard drive
1. Navigate to the C:\Users\[Your username]\AppData\Roaming\Microsoft\Excel\XLSTART folder (see the below screenshot for an example of this file path)
2. [image: ]Copy the provided PERSONAL.XLSB file (this is the file containing the macros). If you cannot see the folder, go back to step one and check the “Hidden items” box so that you can navigate to the folder. [image: ]If there is already a PERSONAL.xlsb file in this folder, you will see a prompt asking if you’d like to replace the file in the destination. Replace the file for the most updated macro file. PERSONAL.XLSB contains all  the macros created to accompany the Insight Reports.

3. The PERSONAL.xlsb file will now run each time you open Excel, and you won’t need to repeat these steps again.
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[bookmark: _Toc74041705]Running the Macro
Steps 3 and 4 need to be completed each time you would like to format the report, so that it is easier to read. 

[bookmark: _Toc74041706]Step 3: Add the Developer Tab (if necessary)  

If you already see the Developer ribbon in your version of Excel, you can skip to Step 4.  It is located between the “View” and “Help” tabs on the top toolbar.
To turn on the Developer tab, execute the following steps (you should only need to do this once):
1. [image: ]Right click anywhere on the ribbon, and then click Customize the Ribbon.
Under Customize the Ribbon, on the right side of the dialog box, select Main tabs (if necessary), and check the Developer check box.

[image: Graphical user interface, text, application, Excel

Description automatically generated]You should now see the Developer ribbon in your Excel menu bar.
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Step 4: Run the Macro
Once the Insight Report is open, 
1. [image: ]Navigate to the Developer ribbon in Excel and choose Macros on the left. (See the below screenshot.)  This will open the Macros dialog box.

2. [image: ]Navigate to the macro whose name matches the Insight Report you are working with. For example, in the below screenshot the macro named PERSONAL.XLSB!ActiveProjects corresponds to the Active Projects Insight Report.  Select the applicable macro and click “Run” as seen in the below screenshot.



The Active Projects file should now be reformatted to exclude any unneeded rows or columns, add a column calculating the time between the First Submission Date and First Effective Date, and create a more visually pleasing, easier to read table, as seen in the below screenshot.
[image: ]

Your Insight Reports are ready to use. If you have any questions related to the macros, please contact Nelson Vasconcelos at nelson.vasconcelos@va.gov.  Direct questions about the reports to govsupport@IRBNet.org.
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[image: ]                                                  	                                                            	     Page | 1                     Goldschmitt and Associates LLC, Getting the Most Out of Insight Reports
Use or disclosure of data contained on this sheet is subject to the restriction on the title page of this proposal or quotation




image1.emf
IRBNet Insight  Reporting Guide.pdf


IRBNet Insight Reporting Guide.pdf


	  


	


	 	
	







	   
 Your Guide to 


 IRBNet Insight Reporting 
	 	


CONFIDENTIAL:  Property of IRBNet Page 2 of 7	
	 	


Your institution’s use of IRBNet generates a rich array of data. The IRBNet Insight Reporting 
service provides you with a detailed set of extracts that give unique and timely views into your 
operations and organizational performance.  These facilitate and empower your Program 
Oversight, Quality Assurance and Quality Improvement activities. 


IRBNet Insight Reports 
IRBNet Insight Reports may be scheduled to run at nearly any interval (weekly, monthly, etc.) 
and are automatically delivered via email right to your inbox.  Reports are delivered as CSV files 
which may be used in Excel or imported into other databases or spreadsheets.  It is 
recommended that you archive all received reports for later reference, as older data will roll off 
your reports over time. 


 


Figure 1: Powerful and complex data at your fingertips. 
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YOUR PEOPLE: 


Registered 
Users 


This report provides you with a list of everyone with an active affiliation to 
your research organization in IRBNet. The report includes information 
such as first and last name, registered email address, phone number and 
registration date.  


Researcher 
Roster 


This report provides you with a listing of all researchers that have access 
to any project that has been submitted to your board. This report includes 
information such as the organizational affiliation of each researcher 
(valuable information if you are the board of record for several 
institutions), the researcher’s email address, and the total number of 
submissions and total number of projects for each individual.  


Project 
Access 


This report provides you with a list of all active projects and every 
individual with access to those projects.  This report is often used as an 
extension of the Researcher Roster report.  This report includes 
information such as the individual’s organizational affiliation, their level of 
access to the project, who shared the project with them and when. 


Training 
Records 


This report provides you with a list of all accepted training records for 
your researchers, committee members and staff.  This report includes 
information such as the name and email address of each individual, as well 
as the type of training, credits and expiration date for each accepted 
training record. 
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YOUR PROJECTS: 


Project 
Status 


This	report	provides	you	with	a	listing	of	the	most	recently	reviewed	submission	
for	each	project	submitted	to	your	board.		This	report	includes	information	such	
as	the	initial	approval	date,	the	current	status,	the	risk	level	and	the	expiration	
date.	Closed, Disapproved, Not Research, Terminated and Withdrawn projects 
roll	off	this	report	after	18	months. 


Project 
Expiration 


This report provides you with a list of every project that will expire in the 
next 90 days and every project that has already expired but has not been 
closed and may require action. 


Unlocked 
Submissions 


This report provides you with a list of all unlocked submissions.  Many 
institutions elect to unlock incomplete submissions during the pre-review 
process to allow researchers or study coordinators to revise 
documentation prior to the submission being shared with the board. This 
report will provide you with a current listing of all packages in an unlocked 
state. 


Submission 
Tags 


This report provides you with a list of all tagged submissions for each 
custom tag.  IRBNet Tags help you to organize submissions, track office 
workflow and communicate valuable submission information to reviewers.  
Submissions that do not have activity for 12 months are rolled off this 
report. 


Global Tags This report provides you with a list of all Global Tags for each project.  
Projects that do not have activity for 12 months are rolled off this report. 


Package 
Signatures 


 


This report provides you with a list of all signatures attached to each 
submitted package.  This report includes information such as the signatory 
name, date and role, as well as detailed information about the package that 
was signed. 
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YOUR BOARD PERFORMANCE: 


Review 
Process 


This report provides you with a list of every submission together with key 
data points to assess review performance.  This data-rich report may be 
sliced to profile office-level activity, characterize committee workload, and 
monitor office throughput.  It includes dates of key events in the review 
process. This report includes information such as the submission date, 
when the submission was first shared with board members, when the last 
board member completed their review, the assigned agenda date, the 
effective date of the action on the submission, and when the first and last 
board documents were published.  Submissions that do not have activity 
for 18 months are rolled off this report. 


Pending 
Review 


This report provides you with insight into the activity of your reviewers for 
submissions that are in a Pending Review state (your board decision has 
not yet been recorded).  If you have a high-volume board, this report can 
allow you to quickly identify opportunities to improve turnaround times. 
This report is a subset of the Reviewer Activity report. 


Reviewer 
Activity 


 


This report provides you with insight into the activity of your reviewers.  
This report is particularly useful for monitoring expedited review 
completion and reviewer workloads.  This report shows when board 
members are doing their reviews and dovetails meaningfully with the 
Review Process report. The report displays key performance information 
for each reviewer on each submission: when they were given access to the 
submission, when they first made a comment, when they made their last 
comment, and when they completed their review, along with other 
submission-specific information.  This report includes all submissions 
where board decisions have been rendered in the past 120 days as well as 
all submissions that are in a Pending Review state. 


Board 
Scorecard 
(Details and 
Summary) 


 


Board Scorecards provide administrators and senior officials with insight 
into individual board member review preparation and performance. For 
each board member, this report details reviewer activities for each 
assigned submission, including review of project documents, whether 
reviews have been completed, and at what points in time. This is extremely 
helpful for demonstrating substantive review. The summary report allows 
you to develop performance graphs with ease. This report set is a valuable 
tool for focused, continuous improvement of committees and their 
members. This report includes all reviewer activity for agenda dates within 
the past 30 days. 
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Meeting 
Attendance 


This report provides you with a list of all meeting attendees for each of 
your committee meetings.  This report provides you with insight into the 
meeting attendance patterns of your committee members, staff and other 
attendees. 


 


ADVANCED: 


Review Time 
Reports 


Review Time Reports provide insight into the time from initial project 
submission to first approval. For IRBs, these reports are available for Full, 
Expedited, and Exempt reviews and provide further utility for those 
institutions that follow AAHRPP’s standard for calculating time to approval 
for each project. Specific insights include: Total Days from Initial 
Submission to First Approval Total Days Between Packages Total Days 
Unlocked, and Total Days from Submission Complete to First Approval. 
For IACUCs, we also provide a Designated Review Time report.  


Active 
Projects 


This report captures a list of all Active projects at your institution, and 
includes all standard project information. 


Work in 
Progress 
(WIP) 
Packages 


This report provides you with a list of all Work-in-Progress packages that 
have yet to be submitted to your board. The report will only include the 
Work-in-Progress packages for projects that have been submitted to your 
board, or where researchers listed your institution as the Research 
Institution for the project. This report will help you predict what packages 
might be coming to your board. It will also help you understand when your 
researchers have completed adding documents and signatures to their 
package, but may have forgotten to click the Submit this Package button. 


Expiration 
Cleanup 


This report provides you with a list of all Closed or Terminated projects 
where an expiration date is listed. This report may be useful if your 
institution has recently experienced administrative turnover, or if you 
would like to prevent researchers from receiving expiration alerts for 
studies that have already been closed out. 


Unpublished This report provides you with a list of all unpublished Board Documents 
and helps you ensure that no Board Documents are mistakenly left 
unpublished. 
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YOUR CUSTOM DATA: 


Smart Form 
Data Extracts 


Many institutions employ IRBNet Smart Forms to collect custom data.  
These extracts provide you with a complete set of your custom data to 
facilitate your detailed analysis. 


 


 


IRBNet Analytics 
As your organization continues to use IRBNet, you may have additional custom analytic needs. 
We are happy to discuss your requirements with you.  Please contact the IRBNet Support Team 
at support@irbnet.org for more information. 
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